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Models Covered By This Reference

This Hardware Reference includes information on the following products:
B AT-8824
B AT-8848

The latest AT-8800 Series Hardware Reference can be found at
www .alliedtelesyn.com/support/software

Why You Should Read This Reference

This Reference provides hardware related information for AT-8800 Series
switches.

The Reference has two primary aims:

1. To familiarise you with the hardware features of AT-8800 Series switches.

2. To assist you with setting up and maintaining your AT-8800 Series switch.

I@: This Reference does not cover software configuration or software installation

procedures. For information on software, refer to the AT-8800 Series Software Reference.
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Hardware Description

This section provides an overview of hardware features for the AT-8800 Series,
as well as hardware descriptions of each model.

Switch Overview

Developed to meet the exceptionally high performance demands of low to
mid-range applications, AT-8800 Series switches deliver hardware-based low-
latency high-bandwidth wire speed Layer 2 and 3 switching, in a robust 1U
platform.

With GBIC and 10/100BASE RJ-45 port options bridging traditional copper/
fibre divides, and hardware expansion options such as Dual In-line Memory
Modules (DIMMs), the AT-8800 Series is a versatile and powerful switching
solution for rapidly evolving networks.

Dimensions
Table 1: Dimensions for AT-8824 and AT-8848.

AT-8824 and AT-8848

Height 1U - 44 mm (plus 5.5 mm if the rubber feet are used).

Width 440 mm (excluding rack-mounting brackets).

Depth 350 mm.

Weight  Not more than 6 kg excluding power cord.

Mounting System

* 1U rack mounting

Environmental Conditions
¢ Operating temperature range: 0 to 50° C (32 to 122° F)
* Storage temperature range: -20 to 60° C (-4 to 140° F)

* Relative humidity range: 5 to 95% non-condensing

Regulatory Standards
AC models
e AS/NZS3260
e (NS 13438 Class A
e BSMI
e VCCIClass A
e  EMC: EN55022 class A, FCC class A, and VCCI class I
¢ Immunity testing to EN55024: EN61000-3 levels 2 (Harmonics), and 3

(Flicker). EN61000-4 levels 2 (ESD), 3 (susceptibility), 4 (fast transients),
5 (power surge), 6 (RF immunity), and 11 (Voltage dips and sags).

e Safety: UL60950, CAN/CSA-C22.2 NO. 60950-00, EN60950, ACA TS001
e (Certification: UL, cUL, TUV
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LEDs

* Port and System status LEDs
* For a complete list of LEDs and their functions, see “LEDs and What
They Mean” on page 26.
Power Supply Unit
AC models
* Universal 100/240 VAC 50/60 Hz input

e Redundant DC Power connection

Maximum Current Loads
AC models

e  Maximum continuous current draw, 0.7A at 240V, 1.5A at 100V
e  Maximum inrush current (cold start at 25° C/77° F), 50A at 115V

Switching Cores
* Application-Specific Integrated Circuit (ASIC) switch chip
* Non-blocking L2 and L3 IP Switching
¢ 8kentry forwarding address database

e 32 MByte SDRAM packet buffer

Processing Core
e 400 MHz RISC Processor
* 64,128 or 256 MBytes Synchronous DRAM on DIMM
* 16 MBytes of fixed flash (expandable to 32 MBytes)
¢ 256 kBytes of SRAM (NVS)
* Battery backed real time clock (RTC)
e 32-bit/33 MHz PCI bus
e Silicon ID chip storing serial number, board ID, and MAC address

Asynchronous Serial Port
e Up to 115 kbps
e Hardware-flow control
* RJ-45 with Cisco pinout
® RJ-45 cable and RJ-45 to DB9 adapter supplied

PCI Accelerator Card (PAC) Slot

¢ For optional 32-bit PCI based hardware Encryption and/or
Compression Card, a PAC interface connection is provided

C613-03066-00 REV E
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AT-8800 Series Switch Models

This section provides hardware descriptions for the individual switch models.

AT-8824

(Front Panel Figure 2 on page 7, Rear Panel Figure 3 on page 7)
® 24-port 10BASE-T/100BASE-TX (R]J-45 connectors)
* 2-port 1000BASE-X (GBIC slots)
¢ Unrestricted 1000BASE-T GBIC use
¢ One DIMM socket for expansion of Synchronous DRAM to 256 MB
¢ Compatible with AT-RPS8000 systems
* Auto-negotiating Layer 3 Managed Switch

Figure 1: Front panel of the AT-8824.

=
=3 oo _

AT-8848

(Front Pane, Figure 2 on page 7, Rear Panel Figure 3 on page 7)
® 48-port 10BASE-T/100BASE-TX (R]J-45 connectors)
* 2-port 1000BASE-X (GBIC slots)
¢ Unrestricted 1000BASE-T GBIC use
¢ One DIMM socket for expansion of Synchronous DRAM to 256 MB
e Compatible with AT-RPS8000 systems
* Auto-negotiating Layer 3 Managed Switch

Figure 2: Front panel of the AT-8848.

RPS INPUT VDC
3
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Online Documentation

This section provides a step-by-step guide to accessing online documentation.
Adobe Acrobat Reader must be installed to view online documentation.

Accessing the CD-ROM and Online Documentation

Follow these steps to access the CD-ROM and online documentation:

1.

2.

Insert the Documentation and Tools CD-ROM in the CD-ROM drive.

If the CD-ROM browser does not appear.
Select "Run" from the Start Menu (Windows 95, 98, 2000 or NT 4.0).
Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

To view a document.

Click on the document title.

To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select
"Reader Guide" from the Help menu.

To install any of the tools included on the CD-ROM.
Click on a link in the CD browser.

AT-TFTP Server

This section provides information on how to access and use AT-TFIP Server.
AT-TFTP Server can be used to transfer configuration files as well as to
download software patches and releases.

3’ To use AT-TFTP Server, follow these steps:
¢

y

2

1.

If AT-TFTP Server has not yet been installed.

Install it now from the AT-8800 Series Documentation and Tools CD-ROM.
Choose AT-TFIP Server from the Start > Programs > Allied Telesyn >
AT-TFTP Server menu.

To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences” dialog
box.

The "Default file transfer directory" field specifies the directory that AT-
TFTP Server will read from or write to for file requests that do not include a
directory specification.

C613-03066-00 REV E
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To prevent unauthorised access to private directories, enter a path name in
the "Restrict to directory” field. AT-TFIP Server will use only the specified
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to
archive scripts created using the switch's CREATE CONFIG command,
select "Read Write".

Make any required changes and click "OK".

Set Preferences ]

A default directory for the TFTP daemon to read and write files from
can be specified. File requests without a directory specification will
usze thiz directory.

Default file transfer directory

c:\wpload
To aid ity. file can be tricted to one directory.
Restrict to directory
|c:\upload

The TFTP daemon can be zet to read only or read and write. In read
only mode, file write requests to your sypstem will be rejected.

¥ Read Only " Read White

To see extra prog diagnosti ges click the trol below on

[V Diagnotic Messages

/ oK xﬁancel ? Help

To load a file from AT-TFTP Server to the Switch.

On a terminal connected to the RS-232 Terminal Port (ASYNO), type the
command:

LOAD METHOD=TFTP FILE=filename SERVER=ipadd DEST=FLASH

where filename is the name of the file to download and ipadd is the IP
address of the PC running AT-TFIP Server.

To save a TFTP Server log.
Select "Save As" from the File menu.

TFIP requests are logged to the AT-TFTP Server main window.
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Using Windows Terminal and
Hyperterminal

You can use a PC running terminal emulation software as the manager console,
instead of a terminal. There are many terminal emulation applications
available for PCs, but the most readily available are the Terminal and
HyperTerminal applications included in Microsoft Windows 98, 2000, and

XP Professional. In standard Windows installations, HyperTerminal is
available from the Communications submenu.

The key to successful use of terminal emulation software with the switch is to
configure the software and switch with matching communications parameters.
The following procedure can be applied to most terminal emulation programs.
Dialog boxes in the procedure are from Windows 2000 and XP Professional.
To configure Windows HyperTerminal for 2000 and XP Professional
1. Start the program in Windows by doing one of the following:

¢ Select Programs > Accessories > Communications > HyperTerminal.

¢ Double-click the Hypertrm.exe icon.
2. In the Connection Description dialog box:

e Enter a name for the connection, such as Admin.

e Select an icon from the scrollable list and click the OK button.

Connection Description 7] x|

Enter a name and chooze an icon for the connection:

W ET =
[ dImir]

lzan:

C613-03066-00 REV E
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3. Inthe “Connect using” field on the Connect To dialog box, select the COM
port on the PC used to connect to the switch. and click the OK button.

Enter detailz for the phone number that you want to dial:

Countryregion: I Mew Zealand [54] j

Area code; IEIB

Phone number: I

Connect using:  |[(mE]h

k. I Cancel |

4. Inthe COMn Properties dialog box, set port parameters as follows, and click
the OK button.

Fort Setlings I

Bits per zecond:

[rata biks: IE j
Parity: IN.:.ne j
Stap bits: |1 =l

Le

Flaws contral: IHardware

Festore Defaultz |

k. I Cancel | Spply |

C613-03066-00 REV E
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5. From the main HyperTerminal window, select Properties from the File
menu. Click the Settings tab, and set the Properties dialog box as follows.

Admin Properties d |
Connect To  Sethings I

— Function, arrow, and ctrl keys act az
% Teminal keys £ Windows keys

— Backspace key zends
f* Cul+H  Del  Cil+H, Space, Chil+H

E muilation:

Auto detect j Teminal Setup... |
Telnet terminal D |ANS

B ackscroll buffer lines: IEEIEI :I

[T Play sound when connecting or dizconnecting

Input Tranzlation... | | ASCH Setup... %I

] | Cancel |

6. Click ASCII Setup to display the ASCII Setup dialog box, and ensure the
following options are not selected:

* Echo typed characters locally
¢ Append line feeds to incoming line ends

Set other parameters as necessary and click the OK buttons on both dialog
boxes to close them.

20 x|
— ASCI Sending
[ Sendline ends with line feeds %
[~ Echotyped characters locally

Line delay: IEI millizeconds.
Character delayw: IEI millizecondsz.

— ASCI Receiving

[T &ppend line feeds to incoming line ends
[~ Force incoming data to 7-bit ASC
v ‘wiap lines that exceed terminal width

Ok, I Cancel

C613-03066-00 REV E
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7. Save the current session by selecting Save from the File menu on the main
HyperTerminal window. This creates a connection icon with the name you
assigned in the HyperTerminal group.

To use the configuration, double-click the connection icon. When the
HyperTerminal window appears, press the Enter key several times; the
switch’s login prompt is then displayed.

Switch Start-up

This section outlines the log in and start-up procedures for your switch.
Although the switch will perform basic switching operations without being
configured, you will need to go through these log in and start-up procedures if
you wish to configure the switch and access its full layer 3 switching
capabilities.

To log In

To log in you must first connect the switch to a terminal or PC. This can be
done using the RS-232 Terminal Port (ASYNO). A terminal cable suitable for
use with ASYNO is supplied with each switch.

Using the supplied terminal cable, or a cable you have made by following the
instructions in “Useful Cables” on page 18, connect your terminal or PC to
ASYNO.

Set the communication parameters on your terminal or terminal emulation
program to:

¢ Baud rate: 9600

¢ Data bits: 8

* Parity: None

e Stopbits: 1

¢ Flow control: Hardware

See “Using Windows Terminal and Hyperterminal” on page 10 for more
information on configuring emulation software.

Ensure that any power switches are in the On position and that the switch is
receiving power.

After the switch has booted, the log in prompt appears. If the log in prompt
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account
with manager privileges. The account has the log in name “manager” and the
password is “friend”.
At the log in prompt, enter the log in name and password.

Log in: manager

Password: friend

The switch’s command prompt appears and you can now configure the switch
using the command line interface.
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Change the password as soon as possible. Leaving the manager account with
the default password is a serious security risk. Make sure that you remember
the new password as there is no way to retrieve it if it is lost.

Use the following command to change the account password:

set password

See the AT-8800 Series Software Reference for more information on configuring
the switch.

To access help
To display a list of help topics, enter:

help

To display help on a specific topic, enter:

help topic

Alternatively, type a question mark (?) at the end of a partially completed
command to see a list of valid options.

Start-up Procedures

When the switch starts up following either a power cycle or an operator-
initiated reboot (using the Reset button or RESTART command), a series of
start-up messages is sent to the terminal or PC connected to ASYNO (Figure 4
on page 14).

Figure 4: Switch start-up messages.

INFO: Self tests beginning.

INFO: RAM test beginning.

PASS: RAM test, 65536k bytes found.
INFO: BBR tests beginning.

PASS: BBR test, 128k bytes found.
INFO: Self tests complete

INFO: Downloading switch software.
Force EPROM download (Y) ?

INFO: Initial download succeeded
INFO: Executing configuration script <boot.cfg>
INFO: Switch startup complete

Manager >

After the self tests are complete, the manager is given the option of forcing a
mandatory boot from the EPROM (Flash) release. The message:

Force EPROM download (Y)?

is displayed on the terminal or PC connected to ASYNO and the switch pauses.
If a key is not pressed within a few seconds, the start-up process will continue
and all steps in the sequence will be executed. Pressing selected keys on the
terminal immediately after the “Force EPROM download” message is
displayed will change the switch start-up process (Table 2 on page 15).

C613-03066-00 REV E
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Table 2: Switch start-up sequence keystrokes.

Pressing key... Forces the switch to...

[Y] Load the EPROM release, with no patch.
[S] Start with the default configuration. Any boot script is ignored.
[Ctrl/D] Enter diagnostics mode.

During the start-up process the switch will generate four different types of
messages. All messages are preceded by one of the words INFO, PASS, FAIL,
or ERROR. The significance of these words is shown in Table 3 on page 15.

Table 3: Switch start-up message classes.

Message Meaning

INFO

An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to
operate.

FAIL An error message that a fatal error condition has caused the system to
halt in an unrecoverable fashion.

The possible messages and their meanings are:

INFO: Self tests beginning.

The code loader tests are about to begin.
INFO: RAM test beginning.

The RAM tests are about to begin.
PASS: RAM test, 65536k bytes found.

The RAM test passed, and the indicated amount of memory was found
and will be used by the switch.

ERROR: RAM test 5. Error address = 00345678.

A RAM test failed, at the given address. In the example, it was the fifth
test run. The RAM test repeats until it passes, so a number of messages
like this may appear. This fault means that the memory system is faulty.
If the fault continues, contact your authorised Allied Telesyn distributor
or reseller immediately.

INFO: BBR tests beginning.
The BBR battery tests are about to begin.
PASS: BBR test, 128k bytes found.

The BBR size/location test passed, with the indicated amount of BBR
found.

FAIL: BBR test. Error address = 12345678.

The BBR size/location test failed at the given location. The test at this
location failed, indicating the end of memory, but a valid location was
discovered in the 255 long words following this location. The BBR
system will need to be replaced. Contact your Authorised Allied
Telesyn distributor or reseller.
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FAIL: BBR test, only 16k bytes found.

The BBR size/location test completed, but only the displayed amount
of memory was found. This amount is less than the minimum required
to run the switch software.

INFO: Self tests complete.
The start-up tests have finished.
INFO: Downloading switch software.

The process of downloading the switch software and vector table from
ROM is about to begin.

ERROR: Code load retried.
FAIL: Code load failed.

The load of the code from ROM to RAM failed. The load is retried a
number of times. Each time a failure occurs, the ERROR message is

displayed. If the maximum number of attempts is reached, the FAIL
message is displayed.

INFO: Initial download successful.

The start-up tests and download are complete, and the switch software
is about to be started.

INFO: Executing configuration script <script-name>

The configuration commands stored in <script-name> are being
executed. If an error is found in the script, one or more ERROR
messages will be displayed.

INFO: Switch startup complete.
The start-up process is complete and the switch will now perform basic
switching operations. Further configuration will be necessary if you wish to

access the switch’s full layer 3 switching capabilities. See your AT-8800 Series
Software Reference for detailed information on configuring the switch.

C613-03066-00 REV E
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RS-232 Terminal Port (ASYNO)

This section introduces the switch’s RS-232 Terminal Port (ASYNO), including
its pin assignment and purpose.

The RS-232 ASYNO Terminal Port is used to connect the switch to a
management device for initial configuration and switch management tasks.
This allows the switch’s software to be accessed from a terminal, or a PC
running terminal emulation software. You can also use ASYNO to establish a
network connection from a remote site using SLIP and a modem.

ASYNO has an RJ-45 socket with an industry recognised pinout. This requires
the use of a straight-through RJ-45 cable with an R]-45 DB9F connector when
connecting the switch to a terminal or PC. The socket is wired as a DTE and the
pin roles are shown in Figure 5 on page 17 and listed in Table 4 on page 17.

See “Useful Cables” on page 18 for more information on suitable cables to use
with ASYNO.

Figure 5: RS-232 Terminal Port Pin Numbers

1 8

RJPINT

Table 4: Internal DTE pin roles.

Pin Role
1 RTS
DTR’
XD
GND
GND
RXD
DSR’
cTS

| N | Ml W|N

1. DTR and DSR are connected together but have no other internal connection.
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Useful Cables

This section describes how to make management, test, and network cables for
use with the switch’s RS-232 (ASYNO) and RJ-45 interfaces.

RS-232 Terminal and Modem Cables

Table 5 list the terminal and modem cables described in this section.

Table 5: Terminal and modem cable descriptions.

Cable type Description
RS-232 RJ-45 to DB9 female terminal cable Figure 6 on page 18
RS-232 RJ-45 to DB9 male modem cable Figure 7 on page 19

Figure 6, and Figure 7 show how to wire cables to connect a standard VT100
compatible terminal, or a modem, to ASYNO.

Figure 6: Pin wiring diagram for a standard DB9 male to female terminal cable.

RJ-45 DE9 Female
(to switch/DTE) (to PC/terminal/DTE)
— (DTR) 2 1 (DCD)
— (TXD) 3 2 (RXD)
«— (RXD) 6 3 (TXD)
« (DCD) 7 4 (DTR)
(GND) 5 5 (GND)
not connected 6 (DSR)
« (CTS) 8 7 (RTS)
— (RTS) 1 8 (CT9)
not connected 9 (RING)
8 1 Pin & Pin 1
”””” Cable
—
RJ-45 Pin View pin 0 Pin 6
DB9 Female Pin View
Notes:
(1) — Output from switch; « Input to switch.
{2; Cable version 1.0.
3 Pin 4 unconnected.

Ciscowiredrj45db%

C613-03066-00 REV E
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Figure 7: Pin wiring diagram for a DCE RS-232 Terminal Port (DB9 male connector)

male to male modem cable.

RJ-45
(to switch/DTE)

not connected

DB9 Male
(to modem/DCE)

— (TXD)
< (RXD)

3 (TXD)

2 (RXD)

« (CD)

1 (DCD)

(GND)
~ DTR)

5 (GND)

4 (DTR)

« (CTS)
— (RTS)

— 0ON O NON WM

8 (CTS)

7 (RTS)

not connected

8 1
I

Cable

9 not connected
6 not connected

Pin 5 Pin 1

—I
RJ-45 Pin View

Notes:

1)
2)

— Output from switch; « Input to switch
Cable version 1.0.

Pin 9 Pin 6
DB9 Male Pin View

RJA5DTEDBOMsw

More information on pin assignments for the RS-232 Terminal Port can be
found in “RS-232 Terminal Port (ASYNO)” on page 17.
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VAN

Cables for RJ-45 Ethernet LAN Interfaces

For 10BASE-T/100BASE-TX/1000BASE-T (10/100/1000BASE) connections, a
twisted pair cable with four pairs and RJ-45 connectors must be used.

Table 6 on page 20 lists the cables used for network connections and testing of
RJ-45 interfaces.

Caution. Do not plug a phone jack into any RJ-45 port. Doing so could damage
the switch. Use only twisted pair cables with RJ-45 connectors.

Table 6: Cables for RJ-45 LAN interfaces.

Purpose Interface type Cable type Pairs Pin assignment
Network 10/100/1000BASE Straight through Four Table 7 on page 21
Test 10/100/1000BASE Crossover or straight through Four Table 8 on page 21 or

Table 7 on page 21

Pin assignments

For twisted pair cables each pair is identified by two different colours. For
example, one wire might be red, and the other red with a white stripe. An R]-45
connector must be fitted to both ends of the cable. Figure 8 on page 20
illustrates the pin layout for RJ-45 connectors.

Figure 8: RJ-45 Pin layout.

RJPIN

C613-03066-00 REV E



Hardware Reference

21

C613-03066-00 REV E

1000BASE straight through cable

For 1000BASE network connections, all four pairs are used and the cable is
wired in a straight-through configuration. This cable can also be used, in
conjunction with the software test facility, to test 1000BASE network ports.

Table 7 on page 21 lists the pin assignments.

Table 7: Pin assignments, 10/100/1000BASE-T RJ-45 four pair straight-through

cable.

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 1+
2 Pair 1- 2 Pair 1-
3 Pair 2+ 3 Pair 2+
6 Pair 2- 6 Pair 2-
4 Pair 3+ 4 Pair 3+
5 Pair 3- 5 Pair 3-
7 Pair 4+ 7 Pair 4+
8 Pair 4- 8 Pair 4-

1000BASE crossover cable

For 1000BASE test cables, all four pairs are used and the cable is wired in either
a crossover or straight-through configuration. Table 8 on page 21 lists the pin

assignments for a crossover cable.

Table 8: Pin assignments, 10/100/1000BASE-T RJ-45 four pair crossover

cable .

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 3 Pair 2+
2 Pair 1- 6 Pair 2-
3 Pair 2+ 1 Pair 1+
6 Pair 2- 2 Pair 1-
4 Pair 3+ 7 Pair 4+
5 Pair 3- 8 Pair 4-
7 Pair 4+ 4 Pair 3+
8 Pair 4- 5 Pair 3-
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Test Facility

This section introduces the Test Facility. The Test Facility is built into all
AT-8800 Series software. For detailed information on operating the Test
Facility, see the Test Facility chapter of the AT-8800 Series Software Reference.

Any interfaces being tested are dedicated to the Test Facility. The Test Facility
can be thought of as a specialised interface module like PPP.

Before using the test facility, disable any configurations
(SET CONFIGURATION=NONE) and restart or reboot the switch.

Ethernet LAN Port Tests

A crossover cable is required to run an Ethernet LAN test. See “Useful Cables”
on page 18 for details of how to make a suitable cable. To start the test, loop a
four-pair crossover or straight-through cable between any two RJ-45 ports and
enter:

ENABLE TEST INT=ALL

A loopback plug, instead of a crossover cable, can be used to test SC and MT-R] GBIC
interfaces.

All interfaces connected by crossover cables are tested. Test results are
displayed with the command:

SHOW TEST

which produces a display like that shown in Figure 9 on page 23. A more
detailed output (with frame counts) can be displayed with the command:

SHOW TEST COUNT

which is shown in Figure 10 on page 23.

Other Interface Tests

Refer to the Test Facility of the AT-8800 Series Software Reference for
information on testing other interfaces.

If a test fails, please contact your Authorised Allied Telesyn distributor or
reseller.

C613-03066-00 REV E
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Figure 9: Example output from the SHOW TEST command, with a test cable between ports 1 and 4.

Board ID Bay Board Name Rev Serial number
Base 148 AT-8848 P1-0 42029694
Duration Details
Interface State Result Type (minutes) Data( %0OK ) Control
portl testing wait 4 minutes TP <1 GOOD (100.0) -

port2 no test - - - - - -
port3 no test - - - - - -
port4d testing wait 4 minutes TP <1 GOOD (100.0) -
porth no test - - - - - -
porté no test - - - - - -
port7 no test - - - - - -
port8 no test - - - - - -
port9 no test - - - - - -
portl0 no test - - - - - -
portll no test - - - - - -
portl2 no test - - - - - -
portl3 no test - - - - - -
portld no test - - - - - -
portl5 no test - - - - - -
portl6é no test - - - - - -

asyn0 testing wait 4 minutes - <1 - - -

Figure 10: Example output for the SHOW TEST COUNT command, with a test cable between ports 1 and 4.

Board ID Bay Board Name Rev Serial number
Base 148 AT-8848 P1-0 42029694
Duration Frame Counters
Interface State Type (minutes) Tx RxTotal RxGood RxBad
portl testing TP <1 000298842 000298841 000298841 000000000

port2 no test - - - - - -
port3 no test - - - - - -
port4d testing TP <1 000298842 000298841 000298841 000000000
porth no test - - - - - -
portb no test - - - - - -
port7 no test - - - - - -
port8 no test - - - - - -
port9 no test - - - - - -
portl0 no test - - - - - -
portll no test - - - - - -
portl2 no test - - - - - -
portl3 no test - - - - - -
portld no test - - - - - -
portl5 no test - - - - - -
portl6é no test - - - - - -

asyn0 testing - < 1 000000000 000000000 000000000 000O0COOOOO
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Redundant Power Supply (RPS)

RPS units enhance network reliability by providing backup coverage for switch
Power Supply Units (PSUs).

AT-8800 Series switches have an RPS connector on their rear panel. The
connector allows the switch to be used in conjunction with an RPS.

When an RPS is required, AT-8848 and AT-8824 models use the AT-RPS8000
system. RPS systems can be purchased separately.

AT-RPS8000

The AT-RPS8000 is a chassis that holds up to four removable AT-PWR8000 RPS
units. To provide backup power to AT-8824 and AT-8848 switches, each switch
must be connected to an AT-PWR8000 power unit, and the power unit must be
installed in an AT-RPS8000 chassis.

Table 9 on page 24 lists the RPS connector’s pin numbers and pin functions, as
found on AT-8824 and AT-8848 switches.

Table 9: RPS Connector Pin Numbers and Functions.

Pin Number Function

1 +12VDC

2 Remote Sense (RS) +5VDC

3 Remote Sense (RS) Ground
4 Remote Sense (RS) +3.3VDC
5 Redundant Power Supply (RPS) Present
6 Ground (+3.3VDC Return)

7 Ground (+5VDC Return)

8 +5VDC

9 Ground (+12VDC Return)
10 +3.3VDC

1 Ground (+3.3VDC Return)
12 +3.3VDC

13 Ground (+3.3VDC Return)
14 +3.3VDC

15 +5VDC

16 Ground (+5VDC Return)
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Table 10 on page 25 illustrates the connector’s pin layout, as found on the rear
panel of AT-8800 series switches.

Table 10: AT-PWR8000 RPS Connector Pin Layout.

16 15 14 13 12 11 10 9

8 7 6 5 4 3 2 1

Pin 16 is at the connector’s top left, while pin 1 is at its lower right.

Specifications

Dimensions
¢ Height = 67 mm (plus 5.5 mm if the rubber feet are used)
¢ Width = 440 mm (excluding rack-mounting brackets)
¢ Depth =360 mm
*  Weight = 6.76 kg with one AT-PWR8000 installed, 10.21 kg with four
AT-PWRB8000 power units installed
Mounting System

* 1.5U rack mounting

Environmental Conditions
¢ Operating temperature range: 0 to 50° C (32 to 122° F)
e Storage temperature range: -25 to 70° C (-13 to 158° F)

* Relative humidity range: 5 to 95% non-condensing

Regulatory Standards
e EMC: EN55022 Class A, FCC class A, and VCCI class A
* Immunity testing to EN55024, EN61000-3-2/3
e Safety: UL60950, CAN/CSA22.2, EN60950, No. 60950-00
e (Certification: UL, cUL, TUV

LEDs
¢ AC supply to AT-PWRS8000

For LED descriptions, see “LEDs and What They Mean” on page 26.

AC Power Supply
® Universal 110/230 VAC 50/60 Hz input

DC Output
e +3.3VDC/16A
e +5VDC/16A
e +12VDC/0.5A
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Port, Connector, and Cable Combinations

This section provides cabling guidelines for each switch model.

Table 11: Cable guidelines for AT-8800 Series switches.

Model Port Type Connector Type  Cable Type' Maximum Cable Length
AT-8824 and 10BASE-T/100BASE-TX RJ-45 CAT5 120 m Max
AT-8848 CATSE

AT-8824 and 1000BASE-X Varies with GBIC
AT-8848

Refer to GBICs user
documentation

Refer to GBICs user
documentation

1. Refer to the IEEE 802.3 standards for further cable information.

Troubleshooting

This section provides information on how to detect and resolve problems with

AT-8800 Series switches and their expansion options.

Other sources of useful troubleshooting information are:

B  www.alliedtelesyn.com/support/software

B The AT-8800 Series Software Reference.

LEDs and What They Mean

The following tables outline how LEDs on AT-8800 switches report faults and

operational activities.

System LEDs

Table 12: System LEDs found on the AT-8800 Series Switch.

LED State

Function

RPS (Redundant Green
Power Supply)

An RPS is connected to the switch and is

supplying power.

FAULT Red The switch or management software is
malfunctioning. PSU fail.

PWR Green The switch is receiving power from the AC

(Power) power source.
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Table 13: Port and GBIC LEDs on the AT-8800.

LED

State

Function

GBIC /A
(Link activity)

Green

A 1000 Mbps link is open. The link is operating
in full duplex mode.

Flashing green

1000 Mbps full duplex activity is occurring.

Amber

A 1000 Mbps link is open.

Flashing amber

1000 Mbps activity is occurring.

GBIC Green A GBIC is installed and enabled.
Amber A GBIC is installed but has not been
recognised.
Flashing amber A GBIC is installed and enabled, but a Tx fault
is occurring.
BASE-T /A Green A 100 Mbps link is open.

(Link activity)

Flashing green

100 Mbps activity is occurring.

Amber

A 10 Mbps link is open.

Flashing amber

10 Mbps activity is occurring.

BASE-T D/C
(Duplex/collision)

Green

The port is operating in full duplex mode.

Amber

The port is operating in half duplex mode.

Flashing amber

Collisions are occurring.

Check these first

Check the power cord connections.

Check that the power supply voltage is stable.

Check that the correct data cables are being used and that their connections

are secure.

Check that any GBICs are correctly installed and that they are compatible
with the switch. See “Gigabit Interface Converters (GBICs)” on page 29 for
more information.

Make sure that other network devices are working properly.

Use the SHOW INSTALL command to check that the latest software release
is loaded. See the AT-8800 Series Software Reference for more information
about obtaining the latest software release.

If the switch is malfunctioning, reboot it by pressing the recessed Reset
button or entering the command RESTART REBOOT. Alternatively, shut
down and restart the switch using its power switch (AC models) or
run/standby switch (DC models).
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Some common problems and how to solve them

Link/Activity LED on any port is off
This can indicate:
B A loose data cable.

B The device at the other end of the connection is not working properly or is
turned off.

B The data cable is not wired correctly.

B The network administrator has manually disabled the port through the
software.

B The port’s selected transmission mode does not match that of the attached
device.

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2. Make sure the device at the other end of the connection is switched on and
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 13 for
more information on how to log in.

5. Ifthe portis Enabled, make sure the transmission speed matches that of the
connected device (auto-negotiating, full or half-duplex).

If the port is disabled, someone has used the software to manually disable it. You should

find out why the port was disabled before enabling it.

Power LED is off
This can indicate:
B A loose power cord.

B A power supply failure.

Perform the following steps in sequence:
1. Check that the power cord connections are secure.
2. Check thatall switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range (100/240
VAC 50/60 Hz for AC models).
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Fault LED is on

This can indicate:

B There is a problem with the switch or PSU.

B The switch or management software is malfunctioning.

B A hardware fault is preventing switch start-up.

Perform the following steps in sequence:

1. Check “LEDs and What They Mean” on page 26 for descriptions and
explanations of LED flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the
RS-232 Terminal Port, check that connections between the Terminal Port
and local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232
Terminal Port connection, you can still manage the switch via Telnet or
SNMP until the problem is fixed.

4. Download the latest software release. See the AT-8800 Series Software
Reference for more information on how to obtain the latest software release.

Expansion Options

This section provides an overview of the expansion options for AT8800 Series
Switches. The following expansion options were available when this Reference
was written. See your Authorised Allied Telesyn distributer or reseller, or visit
www .alliedtelesyn.com/support/software to see if any new options are
available.

Gigabit Interface Converters (GBICs)

GBICs are removable gigabit port converters for switches that have GBIC bays.
GBICs allow users to interchange port types to meet changing network
requirements. GBICs can be purchased when a switch is purchased, or can be
ordered separately as needed.

The following GBICs have been approved for use with AT-8800 Series switches:
Allied Telesyn AT-G9T

Allied Telesyn AT-G8T

Allied Telesyn AT-G8ZX  70km ZX

Allied Telesyn AT-G8SX  550m SX

Allied Telesyn AT-G8LX10 10km LX

Allied Telesyn AT-G8LX25 25km LX

Allied Telesyn AT-G8LX40 40km LX

Allied Telesyn AT-G8LX70 70km LX

For more information about GBICs and the latest list of approved GBICs,
contact your authorised Allied Telesyn distributor or reseller or visitour
website at www.alliedtelesyn.com/support/software .
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Any combination of copper and fibre GBICs can be installed in the AT-8800
Series switches.

RX and TX terminal locations on SC fibre GBIC ports are the reverse of RX and TX
terminal locations on fixed SC fibre ports. When looking at an SC fibre GBIC from the
front, the RX terminal is on the left and the TX terminal is on the right.

GBIC 1000BASE-T Auto-Negotiation

1000BASE-T GBICs support only 1000 Mbps full duplex connections. Although
1000BASE-T GBICs will participate in auto-negotiation processes, they will
only advertise 1000 Mbps. Half duplex, 10BASE-T, and 100BASE-TX modes are
not supported.

While 1000BASE-T GBICs will auto-negotiate at the copper Ethernet level, the
ports will behave as if in fixed 1000 Mbps full duplex mode. This is because the
SERDES connection used by GBIC ports makes the auto-negotiation invisible
to the switch, and so prevents a successful link negotiation.

When a 1000BASE-T GBIC is inserted into a GBIC slot, the port’s auto-
negotiation capability is disabled. This means that the port speed may not be
set to "auto-negotiate". If the port had been configured to auto-negotiate (by
default or by command) prior to the GBIC’s insertion, then this configuration is
overridden for as long as the GBIC remains in place.

Dual In-line Memory Modules (DIMMs)

Synchronous DRAM for AT-8800 Series switches is provided by a single
DIMM. Three memory sizes are supported; 64 MBytes, 128 MBytes and 256
MBytes.

Only Allied Telesyn supplied DIMMS have been tested and approved for use
with AT-8800 Series switches. Using DIMM that has not been approved may
cause unreliable operation and will invalidate the switch’s warranty.

To check how much DIMM is installed, enter

SHOW SYSTEM

For AT-8800 Series switches, DIMMs should only be installed by authorised
service personnel. Unauthorised opening of the switch’s lid may cause danger
of injury from electric shock, damage to the switch, and invalidation of the
product warranty.
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Where To Find More Information

The Documentation and Tools CD-ROM bundled with each switch contains the
complete Document Set for AT-8800 Series switches and their expansion
options, as well as tools for switch management. This includes:

B The AT-8800 Series Statutory and Safety Information booklet, which includes
important safety information and statutory declarations for AT-8800 Series
switches.

B The AT-8800 Series Quick Install Guide, which outlines the procedure for
installing switch units.

B The AT-8800 Series Software Reference, which provides detailed information
on configuring the switch and its software.

B AT-TFIP Server for Windows, for downloading software releases.

B Adobe Acrobat Reader, for viewing online documentation.

These documents can also downloaded from our website at
www alliedtelesyn.com /support/software .

Contacting Us

With locations covering all of the established markets in North America, Latin
America, Europe, Asia, and the Pacific, Allied Telesyn provides localized sales
and technical support worldwide. To find our representative nearest you, visit
Allied Telesyn on the web at www.alliedtelesyn.com.


http://www.alliedtelesyn.com/support/software
http://www.alliedtelesyn.com
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